" METROPOLITAN
Community College

The Commercial Energy Code: Session 7
COMcheck Basics and Advanced Technologies

Instructor: Matt Belcher
Tuesday, February 21, 6-8p.m.
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Housekeeping

= Attendees are muted upon entry
= Questions? Enter them in the chat box

= \Webinar is being recorded — slides and recording
will be sent to attendees

= CEUs available for AIA and ICC
= Email canderson@mwalliance.org with questions

> Course Information available at:
https://www.mwalliance.org/metropolitan-
community-college-energy-code-course



mailto:canderson@mwalliance.org
https://www.mwalliance.org/metropolitan-community-college-energy-code-course
https://www.mwalliance.org/metropolitan-community-college-energy-code-course

&/ COMcheck Learning Objectives:

Basics of using the COMcheck software, reviewing generated
compliance reports and the latest and greatest new features.

1. Obtain an overview of the basic functions and how
COMcheck calculates compliance for the building envelope,
Interior and exterior lighting.

2. Be able to identify the construction specifications needed to
complete a compliance calculation in the software.

3. Learn how to enter the building envelope, lighting, and
mechanical components into the software.

4. Understand how the compliance reports are created and
what they entail.



States That Allow COMcheck

[ American Samoa
[ Guam

[IN. Mariana Islands
[ Fuerte Rico
§ o r [0 U.S. Virgin Islands
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3 Applicable By CountylJurisdiction




- Commercial Compliance Tools

Desktop Software Tools Ffe

I! \/I Web-Based Tools

COMcheck”

Printed Materials

COMcheck-Web"
Compliance Guides
ff ] COMcheck” Prescriptive Tables

Package Generator "




|'n\i]/ COMcheck-Web"

COMcheck-Web simplifies commercial and
high-rise residential energy code compliance.

It performs just like COMcheck, the desktop

version, but you don't need to download or

Install any software on your computer.

« Can exchange files between desktop and
web



http://www.energycodes.gov/comcheck/

COMcheck/COMcheck Web

« The COMcheck software product group makes it

easy to determine whet
high-rise residential bui
alterations meet the reg

ner new commercial or
dings, additions and
uirements of the IECC

and ASHRAE Standard

90.1.

COMcheck also simplifies compliance for building

officials, plan checkers and inspectors by allowing
them to quickly determine if a building project

meets the code.



Commercial Compliance Options

2018 IECC - Prescriptive
v C402 - Envelope
v' C403 - Mechanical

ASHRAE 90.1-2016 | | C404-SWH &
_ v C405 - Lighting 2018 IECC — Performance

AND Pick at Least One C406: ) e Bllele

@R Performance
0C406.2 - Eff. HVAC Performance + C402.5 - Air Leakage
0 C406.3 - Reduced Lighting Power 1 C4O:,3__ Mandatory Mechanical
o Provisions
L C406.4 - Enhanced Lighting « C404 — SWH
Controls

» C405 - Lighting

* Building energy cost to be <
85% of standard reference
design building

QC406.5 - On-site Supply of
Renewable Energy

QO C406.6 — Dedicated Outdoor Air
System

QC406.7 — High Eff. Service Water
Heating

0 C406.8 - Enhanced Envelope
Performance

Q0 C406.9 — Reduced Air Infiltration




COMcheck: Who May Submit?

» The commercial energy code requires that a registered
professional submit compliance documentation (construction
documents and compliance verification).

= |n the IECC, Section C103.1 Construction Documents, General,
the wording states that construction documentation and other
supporting data shall be submitted in one or more sets with each
application for a permit.

= The construction documents shall be prepared by a registered
design professional where required by the statutes of the
jurisdiction in which the project is to be constructed. Where
special conditions exist, the code official is authorized to require
necessary construction documents to be prepared by a
registered design professional.



Landing Page

( ™ Pl—oje[:t fitle Email Address | | Password | lﬂ
ﬁ] COMCheCk.Web : egister i Forgotten Password?

2009 IECC o=

| |_g New Project | rrojecT | REGET A I MECHANICAL [T repors | - | [@

€
|

Code/Location T R e L B L A L Ul Exterior Lighting Areas ]

Code: [2008 IECC v
Seate: ’ Add Building Area ] I = Duplicate ‘ I X Delete ‘
City: | Abbeville A | Building Area Area Description Space Conditioning Area W/
If your location is not included here, choose a nearby
location with similar weather conditions. nl SelectArea Category"' ~ _
Project Type
® New Construction ) Addition ) Alterations
Project Details (optional) ] 3

This information will appear on the Edit Project Details...

compliance report.



imercial Buildings

Building System Compliance Options

Prescriptive
Option

| Envelope I

Mandatory
Provisions Trade Off Energy Code

Lighting | (required for all Option Co m pl ia nce

compliance options)

Mechanical

Total Building
1 Performance
|  Hvac |

|
| swH |




com Check‘?

Vatts/square foot (LPDs)

lechanical

« short wizard to customize a list of requirements applicable to the
system identified



Envelope Trade-Off Methods:

» ASHRAE 90.1 (Pre-2013) Normative Appendix C
Methodology for Building Envelope Trade-Off Option

= 90.1-2007/2010
= 2009/2012 IECC

» ASHRAE 90.1-2013 Appendix C has limited performance
method (EnergyPlus) (New)

» 2015 [ECC Component Performance Alternative (Total
UA) (New)



Project Types:

= New Construction: Trade-off compliance
method

= Addition: Trade-off compliance method

= Alteration: Prescriptive compliance



Commercial Building Envelope Requirements

» Mandatory Requirements:
» Moisture Control
« Air Leakage

» Climate Specific
Requirements:

» Roof

« Above Grade Walls
« Below Grade Walls
« Floor

« Slab

» Skylights, Windows, and
Doors




Landing Page

( ™ Pl—oje[:t fitle Email Address | | Password | lﬂ
ﬁ] COMCheCk.Web : egister i Forgotten Password?

2009 IECC o=

| |_g New Project | rrojecT | REGET A I MECHANICAL [T repors | - | [@

€
|

Code/Location T R e L B L A L Ul Exterior Lighting Areas ]

Code: [2008 IECC v
Seate: ’ Add Building Area ] I = Duplicate ‘ I X Delete ‘
City: | Abbeville A | Building Area Area Description Space Conditioning Area W/
If your location is not included here, choose a nearby
location with similar weather conditions. nl SelectArea Category"' ~ _
Project Type
® New Construction ) Addition ) Alterations
Project Details (optional) ] 3

This information will appear on the Edit Project Details...

compliance report.



@&l Untitled.cck - COMcheck : Standard 90.1-2004

File Edit WView Options R Help

~e \ 90.1 ('89) Code
X
D= : = 90.1 ("99) Standard

Project Envelope 90.1 (2001) Standard  :al

Location v 90.1 (2004) Standard Project Details (optional)
1998 IECC This information will .
P appear
State | Pennsyivar S bbbt - ey | 6% Project Details... |
City Abbottstow 2001 IECC : i
Title/Site/Permit
2003 IECC
Project Type Georgia
O New Constr  Massachusetts Altera
e E_xpand the Screen
Space Conditioning New York OwnerAd like other programs.
Yermont

(& Nonresidential (U Resiaenual () Semiheated

Let’s take a closer
Desianed look at this area.

Area Category (Space-By-Space)

Add Category Only add Areas with lighting alterations
Asea Category Area | wmz ||

——

Envelope T8D Lighting, TBD




COMcheck Basics

= COMcheck is a reflection of the difference
between a 'design' building energy performance
factor (EPF) and a 'code' or budget building EPF.

= The methodology used to determine EPF is
provided in ASHRAE 90.1 Normative Appendix
C: Methodology for Building Envelope Trade-off
Option.



COMcheck Project Specification Steps

> Project

= Building Envelope Components
= Lighting

= Mechanical

= Requirements/View/Print/Save



Information You Will Need:

= Energy Code
= Builder and project location
= Area take-offs for envelope assemblies

[

[

[

nsulation R-values and fenestration
nerformance data

_ighting fixture detalls

Heating and cooling system details

= Service water heating details



Landing Page

( ™ Pl—oje[:t fitle Email Address | | Password | lﬂ
ﬁ] COMCheCk.Web : egister i Forgotten Password?

2009 IECC o=

| |_g New Project | rrojecT | REGET A I MECHANICAL [T repors | - | [@

€
|

Code/Location T R e L B L A L Ul Exterior Lighting Areas ]

Code: [2008 IECC v
Seate: ’ Add Building Area ] I = Duplicate ‘ I X Delete ‘
City: | Abbeville A | Building Area Area Description Space Conditioning Area W/
If your location is not included here, choose a nearby
location with similar weather conditions. nl SelectArea Category"' ~ _
Project Type
® New Construction ) Addition ) Alterations
Project Details (optional) ] 3

This information will appear on the Edit Project Details...

compliance report.



(] = |
Project Envelope
Location

State Pennsylvar
City Abbottstow

Project Type
O New Constr

Space Conditioning '

(& Nonresidential

Area Category

&l Untitled.cck - COMcheck

90.1 (2001)
v 90.1 (2004) Standard
1998 IECC
2000 IECC

2001 IECC .

Code: Standard 90.1-2004

Title Bar
Menu Bar

Toolbar

2003 IECC
Georgia
Massachusetts
Minnesota
New York
Vermont

Alterations

(U rResigenual () Semiheated

Area Category (Space-By-Space)

| AddCategory | Oniy add Areas with lighting alterations

Area | wm2 |

:17 | Click to select category. >

— 125 pake sure the
correct code is
chosen

EBX)

Envelope

| Edi Project Details...

J

TeD Lighting TBD




Envelope Requirements

r
DoFE »  we X= &
| L Peect Emeope Mool oM Extesor Laplong  Mechanxd
R . il P AR S o i GRSk

-”:.cunnu: [ tnﬁ“w;. ----- 2 mi'
| Comeseen Asowry Dortie | Commottion | “aesun || madien | bnidaten | w-racre Inx g~ sevd |
| | | Mot | KoVawe B Vawe | !

|

_lﬁ; |
1 Rsetl Triiron Ertrely 4D 250 | 0038 |
* Exmoar Wad 1 Contrete Tk PED) .
3 wedowl | Weod-Framed, 16° o.c. 0550 (035 | 145 ||
4 esow? | Weod-framed. 24%o £ 8% Joas| s |
$! Wadow ) Steel-Framed, 16" 0.C. 8550 (035 345 ||
6 Deer 1 Steel-Framed 28" o 100 |
70 Ooerz | Metal Buikdng wat A 13 |
s Doer3 L So¥d Concrete . e e > - 150 |
= g 6150 '
Sl Other (U-Factor Option) » &, Parsially Crouted, Cells Empty o | : 1)

w87, Partially Crouted, Cells nsulated |
6", Unreinforced, Cells Emgty
&, Unreinforced, Cells Insulated

5", Solid Grouted |
£, Parvially Crouted, Cells Empry '
£, Parvally Ceouted, Cells nsulated

&, Unreinforced, Cells Empty

£, Unreinforced, Cells Insulated

107, Solid Crouted

107, Parsaly Crowted, Cells Empey
107, Partaaly Crowted, Celly Insulated
107, Unreinforced, Cells Empty

10, Unreinforced, Cells Insulated

12", Selid Grouted
12°, Partally Ceownted, Cells Empey
12°, Parvaly Crowted, Cells insulated
12°. Unreinforced, Celis Empty

| 12% Unreinforced, Celis Insulated

Ervelope PASIES: Dewgn 1% bater (har Code Trakme | <18 wieer Ughtrg TRD  Crtecer Ughteg  THO Q'



U/A Trade-Off Compliance

Cormphance Passes wsng UA trade off

Comglance. 12.2% Better Than Code Maxrrum UA: S00 Your UA 439
The % Mt o Ve Thae Code et afade how s 1 tengtaron Ba Doune & Sened of wde Date-o™ o
T T B v G B S @G e s e b R . -

Gross Cavity Cont Glarng

Assembly Area ov RVahwe RVihwe orDoor

U-F actor
Extence Wil Type A Stewd Fraeme, W0 e 1220 130 S0 &
Window 2° Wood Frame Double Pare w Low-E ™ 03X =
Docr B Sobd 41 040 7
Extencr Wall Type B: Steel Frame, 18700 213 130 50 173
Window 1 Wood Frame Double Pane wih Low-E 210 03 =
Window 2 Wood Frame Doutie Pare wi Low-E x 0330 10
Window 3. Wood Frame Double Pare wih Low-& S 030 2
Do A Gass M 030 7
Rocf Type 1 Sheel JostRafer, 8" 0.0 2x70 823 o0 ¥0 21
Window 4 - Skyfght Metal Frame with Thermal Breax Trple Pare 2 0700 b
Window £ - Skylight Cther K 0540 -

Conplance Ststermert The proposed bulding desgn descarbed here 5 consstent with the bulang tlans. specficatons, and other
calouiatons subralied wilh the permit Jppicaton. The proposed buldng has Deen desgied 10 Meet he 2010 New York Energy Conservan
Corstructon Code regumements in REScheck Verson 4 4 1 and 10 comply wih the mandaiory requrements 15300 n the RESaheck inspect
Checkist

Name - Toe e Date



Envelope Screen

&4 EZ-Casestudy.cck - COMcheck Code: 2001 IECC
File Edit View Options Code Help

D FEH ¥ @ X2 &

Project 2 Envelope | Lighting Mechanical

| Roof || Skylight || Ext. Wall || Int. Wall || Window || Door || Basement || Floor |I7
- Cavity C
Componer:\ Assembly C“[;S;:icsm“ }o-sm/ea insulation | |
\ R-Value
_”

Building B0 S

1 Roof 1 Non-Wood W‘W 20532 2 19.0

Building Components are added by clicking on these.

7




Windows — U-Factors

Table 102.3(1)

U-Value Default For Windows
Glazed Doors and Skylights

Frome Mateyial arad Prochsct Typse Sanpgle Dhomsbales
Mietud withant thesraal brealc
Opevabie (rchaing Sy arsd ssgeg
phess done) 1.27 D.B7
Fooexd 1.13 D&
Gasrden Wawiow 26D 1831
Castan Wall 1.2 D™
Syl 1.58 131
Site e seyabied Siopesifoveshessd plecang 1.36 D22
Eetad with thesraal breslc
Opevabie (rchadng Sidng ared serngeg
phess doaw)
Fooexd 1.08 D&
Garden Wewiow 1.07 Da3
Cawtan Wall 111 D62
3oyt 1.89 111
Site Shopweify phezing 1.25 D.7D
< o T e p—
Opevabie (rchadng siding ened sengeng gless
s} D.50 D57
Fixed D58 D56
Siyfght= 1.75 1.05
Wond vy iTierpless
Opevahbie (rchaing sidng ered sy
phass doxws) D8 D55
Fooexd D58 D.5SG6
Geasden Whaniowr a3 1..a
Siryfpge 147 D.B4

Single Pane Double Pane Triple Pane
‘ U=105 MU=OSS MU=037

> NFRC tested and certified
or default window U-value
range

> Use assembly U-value

> All windows must meet or
exceed

=



Type in chat or unmute

QUESTIONS SO FAR?



Mandatory Interior

Requirements

Requirements s Lighting Power

Controls

Switching

The building complies if its total connected power is
no greater than the interior lighting power allowance

Total Connected Interior Lighting
Power (805.4.1) < Power Allowance

(805.4.2)

Entire Building

| Partial Building |




Adding Lighting

EZ-Casestudy.cck - COMcheck Code: 2001 IECC
File Edit View Options Code Help

DFE ¥ W@ Xi= &

Project = Envelope  Lighting | Mechanical

| T8/T12 Fluotescent " Compact Fluorescent I HID Incandescent Add Space

Y e i
2 Sres Lamp Description/ Lamps Per Number of Focdture
Component wture |ID Fudure Description Wattage Pes Lamp Ballast Fdure Fodwes Wattage
Building
1 | = Space 1 |
2 - . polic Troff 40w o | - 174 138
Lighting components are e s Sieoatc 58 4
3 ki Jolic Troffer 146" 71240 wiMegnetic =fl 2 ~fl 31 | 70 |
« | added by clicking on these folcTrotfer |48 T12 4OW elleonatic Sl 2l = =
5 | =——rETTTrzrOOTETTETTT =r=rretatic Troffer |24 T12U 40 v|Magnetic ~|| 2 ~ 53 70
6 T8 T12 Fluorescent 2 E 2 x 4 Prismatic Troffer 458" T12 40W w | [Magnetic - E .
Lighting Results r—
i ' 15 g 31186
Allowed Wattage | | Proposed Wattage |

Envelope | TBD | ugming{ JET !

Use the Options Menu to Arrange Lighting Fixtures by Spaces.




y p,ace-"by-sjﬁéce

Office A

Future
Bath- Development
rooms
Corridor
Retail A
Retail B
Office B

Total Building Area = 3000 ff




= Mechanical

@i EZ-Casestudy.cck - COMcheck Code: 2001 IECC =13
File Edit View Options Code Help

DEE X am XE &
. Project Envelope Lighting Mechanical

[_HVAC System [ Plant [ Water Heating | oy o 7 ]L

Component s E quipment Fuel Type/ Condenser System
e Capacity Heat Sowce Type Detads
Buiding

1 }—-MM‘I 2 Click here.... =

12 | S HVAC System 4 |

3| Rooftop Packaged Heat | _ Select =l |Select =]

_4 | = HVAC System 1 1 j— | |

.S | Rooftop Packaged Heat Py 6SkBtuh | |Arr-Cooled _~|

_8 | = HVAC System 2 7 | !

7 | Rooftop Packsged Hest PU 5kBtuh | Aw-Cooled _w|

'8 | = HVAC System 3 , 2 | |

(9] Rooftop Packaged Heat Py |»=90-<135k... ~|| |Ar-Cooled | Air Economizer
The Mechanical section generates a customized list of mandatory
requirements applicable to the mechanical components you identify.

Envelope | TBD Lighting = -10% |
lUse the View Menu to display Requirements.




@i EZ-Casestudy.cck - COMcheck-EZ

File Edit View Options Code Help

= HVAC System 4

Rooftop Pad

Rooftop Pad

= HVAC System 2

Rooftop Pac

= HVAC System 3}

wcoumonlsww-

Rooftop Pac

HVAC Equipment Type:
Heating Equipment Type:
& None
O Central Furnace
O Duct Fumace
O Hydronic or Steam Coil
O Heat Pump

O Radiant Heater
O Unit Heater
O Other

Zoning Category:

Code: 2001 IECC

Cooling Equipment Type:
(& None

O Field-Assembled DX
(O Hydronic Coil

System

O Packaged Terminal DX Unit
(O Rooflop Package DX Unit

O Split DX System
(O Other

| ok | [ Cancel |

Envelope

TBD

Lighting

0%

Use the View Menu to display Requirements.




<4} EZ Casestudy.cck - COMcheck-EZ Code: 2001
File Edit View Options Code Help

DEE 2 m XE &

c. % E quipment Fuel Type/ Condenser System
Capacity Heat Sowce Type (Deuic

I

1 Chck here .

- 2 | = HVAC System 4 1 :

B Rooftop P ged Heat Py

:; = w‘:s\’::"” ~ L. ll [] System Has a Caculation Pump

& = HVAC System 2 - | [[] Heat Trace Tape Installed in the System

i'7 Rooftop Packaged Heat Py <ss| oK Cancel

8 | = HVAC System 3 2 | | L J L J

= Rooftop Packaged Heat Py e L SR ] i B | Ajr Economizer o |

Envelope | TBD | Lighting | 10% |

Use the View Menu to display Requirements.




Building Controls are Complicated

= Since 2004, about 30% of all new
requirements have been related to building
controls

= Control requirements can be difficult to
Implement, and verification is beyond the
expertise of most building code officials

= Assumption is that they are implemented and
working correctly

Source: https://www.pnnl.gov/main/publications/external/technical reports/PNNL-26348.pdf



https://www.pnnl.gov/main/publications/external/technical_reports/PNNL-26348.pdf

Mandatory Requirements in COMcheck Software

> Requirements Checklist generated automatically based on input
« applicable code
« building location

Esvelope Corpliance Ceortificate
2001 IECC

CORMRe M2 Strmart ¥ armom 3 D Faream 3

Dama Mesas C \Program FieoCReck OO Reck. BIC

Sectien I Exepect Baf erznation

Mo comaces Air Leakage, Component Certification,
— " and Vapor Retarder Requirements:

Snstos on All joints and penetrations are caulked,
o e gasketed, weather-stripped, or otherwise
sealed

Section 2 Ceonecal Inf cxraasion

B s ]

| A Lensmge. Compone st CorPTwarion amd Vayon Keatardey Foque ¢ wews
I R e R s -
111 7 adomn Goorm aed MY Carnted e me che ) HEERRe roqurtEst et

111 3 Compovee B B G- Faosrs e d a8 Cos hed




Systems Commissioning and Completion

Requirements
Section C408

Benefits of Commissioning

> Commissioning Is critical to 9 JrLﬂ Eﬂ

ensure that buildings are

working as designed o;;;':ff%;z s e
= Preliminary and final reports IEE& e
required M

= Mechanical and lighting
commissioning detailed In
section C408




Functional Testing of Lighting Controls
Section C408.3.1

= Prior to passing final inspection, registered
design professional to provide evidence that
lighting control systems have been tested to
ensure that control hardware and software are
calibrated, adjusted, programmed and In proper
working order per construction documents and
manufacturer’s installation instructions



Compliance Certificate for Permit

- COMcheck

COMcheck Software Version COMcheck-Web
Envelope Compliance Certificate

Project Information

Energy Code 2012 Ontario Building Code and Chapter 2 of Division 3 of SB-10(2017)
Projoct Title OAA Festival Project 44%

Location Toronto / Downtown, Ontario

Climate Zone S5a

Project Type New Construction

Vertical Glazing / Wall Area 43%

Performance Sim. Specs EnergyPlus 8.1,0.009 (EPW: CAN_ON_Toronto.716240_CWEC .epw)

Construction Site Owner/Agent Designer/Contractor
666 Park AVe ima Driven Gerry Conway
Toronto, Ontario MAM 4M4 CanDo Developments Conway Architect Inc
666 Park Ave 185 Mafeking Ave
Toronto, Ontario MAM 4M4 Ottawa K1K2va4
6136015689 6136015689
Ima.Driven@CanDo,ca ConwayArchitect@gmail.com
Building Area Floor Area
'1-Gnd F1. Retail (Retait) : Nonresidential 10000
2-2nd - 10th (Office) : Nonresidential 90000

3-Bsmt (Warehouse) : Nonresidential 10000




Advanced Building Envelope
Components - Section C406.8

C406.8: Enhanced Envelope Performance.

= The total UA of the building thermal envelope as
designed shall be not less than 15 percent
below the total UA of the building thermal
envelope in accordance with Section C402.1.5.



Advanced Building Envelope
Components - Section C406.9

C406.9: Reduced Air Infiltration

= Air infiltration shall be verified by whole-building pressurization testing
conducted in accordance with ASTM E779 or ASTM E1827 by an
independent third party. The measured air-leakage rate of the building
envelope shall not exceed 0.25 cfm/ft2(2.0 L/s x m2) under a pressure
differential of 0.3 inches water column (75 Pa), with the calculated
surface area being the sum of the above- and below-grade building
envelope. A report that includes the tested surface area, floor area, air
by volume, stories above grade, and leakage rates shall be submitted
to the code official and the building owner.

= Exception: For buildings having over 250,000 square feet (25 000 m2)
of conditioned floor area, air leakage testing need not be conducted on
the whole building where testing is conducted on representative above-
grade sections of the building. Tested areas shall total not less than
25% of the conditioned floor area and shall be tested in accordance
with this section.



Advanced Technologies

= Advanced Insulation/Building Envelope
= Phase Change Materials

= Systemic Approach to Building

= Advanced Fenestration

= Advanced HVAC Equipment

= Smart Homes

= Electric Vehicles

= Grid-Integrated Efficient Buildings (GEB)
= Carbon Defined



Building Envelope

= Sometimes you can get a free lunch! FREE ENERGY starts
with good, thoughtful design!

S[/MM
kR
Summer Suy

Shading Q

<e—— Continuous Glass
; Insulation
Overhang — e
Protection
Factor=A/B v, sae O, . err wgenere.
. >
I ” m

| S

Thermal Mass

Projection Factor Solar Angle

Images: up.codes ecodesignadvisor.org.nz



Continuous Insulation - Typical Framing

* Typical wall with
continuous insulation
on the exterior

Single Top Plate
2x6 stud wall @ 24" o.c.

Taped and painted 2"
gypsum wall board as
interior finish

XPS insulating exterior
sheathing: 1” to 4” typical

* Be sure to seal all
seams In continuous
Insulation

Tape joints in XPS
sheathing

Furring Strips

Cladding

» Stud cavity can
accommodate various
types of insulation

Image: buildingscience.com



Continuous Insulation - Advanced

Framing

> Double stud wall
allows for continuous
insulation to be
placed between
Interior and exterior
studs

» Can accommodate
various types of
Insulation, or even
mixed types of
Insulation

2x3 interior wall

Taped and painted Single top plate
°fg" gypsum wall
board as Interior finish 2x4 exterior wall @ 16" o.c.
Smart vapor retarder
on exterior of gypsum
board
9'/," ocSPF insulation fills
cavity

/2" plywood sheathing

Spunbonded polyolefin
(SBPO) air and water
barrier

/2" furring strips

Fiber cement lap siding

oCcSPF at rim joist

Image: basc.pnnl.gov



3 Main Types of Rigid Insulation

\

Image: finehomebuilding.com

Expanded
Polystyrene — EPS
» Least expensive
* Most vapor

permeable
* R-value: 3.6 to
4.2 per inch

Extruded
Polystyrene — XPS
* High compressive
strength

 High initial water
resistance

* R-value: 5 per
inch

Polyisocyanurate -
Polyiso

* No ozone depleting
blowing agent

» Absorbs water/
requires facing

* R-value: 6 to 6.5 per
inch



Comparing EPS and XPS

= Standardized tests show XPS has much lower water absorption, but
one study of a below grade installation showed a different result.
The takeaway — carefully research before selecting materials.

100

RETENTION

%

Foam-Control EPS
Typell

Extruded Polysytrene

52
18.9
4.8
S
% R-Value % Water Absorption
Retention by Volume

WATER ABSORPTION AND R-VALUE RETENTION"

Retained thermal
resistance and
water absorption
of insulations
subjectedto 15
years below grade
exposure

/4" EXPANDED POLYSTYRENE (EPS)

Property Units ASTM Test Type |
Density pef, minimum €303 .90
Thermal Resistance per 3/4° thickness C518 2.7
Value (R) @ 75°F (23.9°C)

Compressive Resistance psi, minimum D1621 10
10% Deformation

Water Vapor Permeance perm-in; maximum E96 5.0
Water Absorption % by volume max ca2r2 4.0

/4" STYROFOAM EXTRUDED POLYSTYRENE (XPS)

Property Units ASTM Test
Density pef, minimum €303 1.6
Thermal Resistance per 3/4" thickness C518 348
Value (R) @ 75°F (23.9°C)

Compressive Resistance psi, minimum D621 25
10% Deformation

Water Vapor Permeance perm-in; maximum E96 1.1
Water Absorption % by volume max car2 n|

Images: guardianexts.com; globenewswire.com




Phase Change Materials

= Store thermal energy via Concatl

imcorporated with

the latent heat of phase re
tranSItlonS Heat 18 released
Tt . ' "
= Buffers thermal swings in =~ 8> Comon e
buildings

Image: sciencedirect.com

= Stores solar thermal energy for
short-term or seasonal
applications



Systems Built Components:
Reimagining the Process

> Time!

= Engineered or “Manufactured” Off-Site Construction
= | ocal Labor/Trades/Material Suppliers

= |ocal Trade School Engagement

= Potential of Utilizing Local Facilities
— Allows for expansion of market
— Local lenders/appraisers

= Prefab/Modular Largest growth segment in housing
market



Panelized, Systemic Construction

Time = Money!
Enclosed and Insulated < Week



Modular/VVolumetric

= Highest Growth Segment of the
Housing Market

> Non-chassis based

= Can be custom built

> Built indoors/climate controlled
= Higher quality control

= |[nspected by ICC or other 3rd

party ‘
> Very COSt COmpetItlve Image: nashuabuilders.com




Modular/VVolumetric

= GGaining single family
market share

= REALLY gaining multi-
family market share

Image: bonestructure.ca; columnandbeam.com



Cutting Edge Windows: Thin Triple
Pane and Vacuum Insulated Glazing

Image: eta.lbl.gov Image: agc-glass.eu
Thin Triple Pane Vacuum Insulated Glazing
« Lighter than standard * Very thin vacuum gap — 1/10
triple pane mm!
- Adds strong, thin, non-  Clear structural spacers
structural center pane maintain gap
« As high as R-8  Thinner than standard double
(standard double pane pane

is R-2 to R-4) « Could be as high as R-14



Window Technologies — Dynamic
Glazing

= Any fenestration product that has the fully reversible ability to
change its performance properties, including U-factor, solar heat
gain coefficient (SHGC), or visible transmittance (VT)

Image: dwmmag.com



Phase Change Materials

= Phase Change Materials (PCMSs)

> Ability to store heat gains then release stored
energy at appropriate time

» PCMSs can

— Reduce energy usage
— Increase thermal comfort

— Smooth out temperature fluctuations throughout the
day and night

— Help reduce and/or shift in peak loads



High Performance HVAC

= High Efficiency Furnace &
— 98 AFUE ‘
— Variable Speed Motors

> Heat Pumps
— As much as 400% efficient  mage: sosgooguy.com
— Cold Climate Heat Pumps
— Mini-Splits
— Geothermal Heat Pump

2w Images: oldhouseonline.com



High Performance Air Conditioning

* Condensing Unit
 Variable speed

* Performance Levels
« 13 SEER required by code
* 14.5 SEER = EnergyStar
 Units over 20 SEER are available
 Tighter envelope increases efficiency

« Advancements in Technology

« National Renewable Energy Lab images: bobmimsiBi
(NREL) is developing an air conditioner
with integral phase change materials!




High Performance Water Heating

uuuuuu

Image: tankleswaterheaterhub.com Image: energy .gov

Tankless Water Heater Heat Pump Water Heater
» Gas or electric Typical efficiency factor (EF) of

» 24% to 34% more efficient in low 2.0-3.0
use homes (<41 gal/day) » Typical gas fired EF is 0.5-0.7
* 8%-14% more efficient in high « Can be efficiently combined with
use homes (~86 gal/day) geothermal heat pump system
 Higher initial cost but offset by * Install in tempered space (40°-
longer life and lower maintenance 90°F)

Fairly new to the market



System Technologies & Management

= Rapid growth

— According to some estimates there will be 63
million smart homes in U.S. by 2022

= Mainstream use

— 86% of millennials would pay more for a smart
home

> |_ower costs
— System management
— Appliances

= Competition!

Image: home.howstuffworks.coma



Systems Commissioning and Completion Requirements
Section C408

= Commissioning IS critical to  Benefits of Commissioning

ensure that buildings are |
working as designed 9 _ﬂ\." Eﬂ
= Preliminary and final reports improved

occupant comfort Increased documentation of
and salisfaction  building system life

req u I red res;:t;r;%ér:lalsher m:mz:;?sm

= Mechanical and lighting | |
commissioning detailed Iin |:E $
section C408 |

Efficient and
opumal Increase in the

‘p"e'lfd' ance from assel and

" the systems expected rental
lé::i?ﬁ?:;‘em, value associated
complaints with a building, etc.




EV Ready and EV Capable

= EVs are growing fast and
qguickly becoming cost
competitive

— Estimated to be cost
comparable by 2023

= EV Ready:

— Capacity on the electrical
panel for at least a 40 amp, : .mage- tks“.T“‘
240V dedicated branch circuit. |

— Conduit pre-installed
— Level 2-ready outlet installed




EV Ready and EV Capable

= EV Chargers

— Level 1 EVSE — Charging through
120V AC plug

» Adds 2-5 miles of range per hour of
charging

» No special equipment, but does require
dedicated branch circuit

— Level 2 EVSE — Charging through 240
V AC plug

» Adds 10-60 miles of range per hour of
charging

» Requires special charging equipment
and dedicated electrical circuit of 20-100
amps

» More expensive than Level 1

> EVs can also serve as a home
battery in the future




Solar

= Solar-ready homes: Same
design considerations as a
home with solar. Panels to be
added later.

» Solar installation:

— Best perform on south facing roofs, }
with 15-40 degree slope |

— Ensure roofing materials can
support panels and a racking
structure

— Electrical panel installed to handle mage:Homedepa o
the load, and wiring to connect to
solar panels




Energy/Battery Storage

= Growing part of Energy
design
— AC, DC and hybrid

converter systems
— 2.5 kW to 10kW Storags “Enerey

> Benefits
— Pair with solar
— Energy and peak savings

= Next Step towards a
micro grids




Microgrids

= A small, decentralized group
of electricity sources and
loads

> Normally operates connected
to the traditional grid

> Can "Island mode" and
function autonomously

— Resilience benefits

> Saves energy because of the
reduced transmission losses

= Saves even more energy,
depending on the
microgrid's storage capability,
power source and other
factors

Other
e Renewables /\

Generalo l B User

Backup l
\ / P
S —
S5
/ - E:E User
Umy% %; -
\ /,l
im W User
\
Solar 0 &
Energy
PITTN - User
Battery
Storage

Image: strategicmicrogrid.com



Grid-integrated Efficient Building (GEB)

= Highly efficient building
= Smart technology
= Two-way communication with the grid
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Carbon

What is a carbon credit?

= A carbon credit represents one unit of
greenhouse gas (GHG) emissions reduced
or carbon dioxide removed from the
atmosphere.

= Carbon credits can be used to offset
emissions.



Carbon Cycle

Sunlight CO2 in the
l atmosphere
Photosynthesis
by producers Fossil fuel
Plant combustion

\respiration

Animal
respiration
Carbon fixation

by consumers

\ D:ec_ornjl:‘osition




Carbon

CARBON IMPACTS OF INSULATION

kgCO, represents R-20 at 234 m* O, emitted

EXTRUDED BDENSTYRENE (XPS) _
CLOSED CELL SPRAYFOAM (HFC) Sy
'

CLOSED CELL SPRAYFOAM (HFO) -
EXPANDED POLYSTYRENE (EPS) {1
MINERAL WOOL BATT {11
FIBERGLASS BATT _
DENIM BATI'E

DENSE PACK CELLULC

EMISSIONS
& INFLUENCED
LARGELY BY
SOURCE
ENERGY TYPE

co,
N
©2019 2030 Inc./Architecture 2030. All Rights Reserved Carbon impacts data source: Build 1 - 2019 White Paper

“Low-Rise Buildings as a Climate Change Solution”, Chris Magwood, 2019;



The Low Impact, Energy Efficient, Resilient,
Healthy, Cost Effective, Comfortable, Grid
Interactive, Place we call Home!
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Next Week

= February 28, 6-8 p.m.

= Topic: Business Benefits, Marketing, Course
Review and FINAL EXAM!

= Contact Matt with Questions:
matt@verda-solutions.com



mailto:matt@verda-solutions.com

Upcoming Events

= Online Energy Code Training

— Nebraska Commercial Energy Code: Air Infiltration,
Lighting and HVAC

— Wednesday, March 15, 2023, 10 a.m. — 11:30 a.m.

> Energy Codes Collaborative Meeting

— In-person in Lincoln at NDEE
— Wednesday, April 26, 9 a.m. — 11:30 a.m.
— Lunch provided



https://www.eventbrite.com/e/nebraska-commercial-energy-code-air-infiltration-lighting-and-hvac-tickets-520889964907
https://www.eventbrite.com/e/nebraska-energy-codes-collaborative-spring-meeting-tickets-548127182157

SEE YOU NEXT WEEK!
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